# Contents

Welcome ................................................................. 2
Disabling Pop-up Blockers ............................................. 2
Accessing the CRMLS Matrix Platform ............................... 3
CRMLS Matrix Platform Navigation Overview ..................... 5

Post Conversion Tasks .................................................. 12
Verify Your Contact Information ..................................... 13
Create an Email Signature ............................................. 15
Create Headers and Footers .......................................... 16
Check your Contacts ..................................................... 19
Check Your Listings ..................................................... 20
Update Your Listings ................................................... 23
Check Your Saved Searches and Auto Prospects ................. 26
Re-enable Auto Prospects (Auto Emails) ......................... 27
Download the Latest Listing Input Forms ......................... 31
Download the Latest 1004MC Solution and Manual ............. 31

Searching for Listings .................................................. 32
Basic Search .............................................................. 32
Map Search ............................................................... 36
Viewing Search Results ............................................... 40

Printing Listings and Reports ......................................... 44

Emailing Listings ........................................................ 46
Emailing Listings for Display in the Client Portal ............... 46
Emailing listings as a PDF Report ................................... 48

Searching for Open Houses ........................................... 50

CRMLS Support Resources ............................................. 51
Customer Support ....................................................... 51
Training Resources ...................................................... 52

Appendix ................................................................. 53
Searching for Listings on Your Mobile Devices .................. 53
Adding a Public Search Link to Your Website ................. 53
Welcome

Welcome to the CRMLS Matrix Platform. CRMLS Matrix is the industry’s top rated MLS platform offering an ultra-modern and flexible environment. This manual will help you verify that all of your information was migrated from your original MLS, give you a basic introduction to the CRMLS Matrix Platform, and guide you through performing basic searches, viewing search results, and printing and emailing listings. Follow the steps in these sections to get started.

• “Disabling Pop-up Blockers” below
• “Accessing the CRMLS Matrix Platform” on page 3
• “CRMLS Matrix Platform Navigation Overview” on page 5

Disabling Pop-up Blockers

Your computer may have an Internet browser or security software that blocks Internet pop-ups. CRMLS products utilize help screens and other features that may be blocked by some pop-up blockers. Follow the steps below to allow pop-ups from CRMLS products in Internet Explorer.

Note:
For information on allowing pop-ups from CRMLS products in other Internet browsers or security software, refer to your application’s documentation.

1. In Internet Explorer, select Tools > Pop-up Blocker > Pop-up Blocker Settings.

2. Add the following websites to the Allowed sites list:
   • http://crmls.org (CRMLS Website)
   • http://www.mrmlsmatrix.com (CRMLS Matrix)
   • http://realist2.firstamres.com (Realist Tax)
Accessing the CRMLS Matrix Platform

The first time that you log into the CRMLS Matrix Platform, you will be taken through a login enrollment process. Follow the steps below to access the CRMLS Matrix Platform.

2. Click the **CRMLS Matrix** button.
3. Enter your Discover Username in the User ID field.

4. If you have recently changed your password in Discover, enter your current password in the Password field.

   If you haven’t recently changed your password in Discover, or are having difficulty logging in, try using “discover” as your password. Once you log in, you will be prompted to change your password. If you’re still having difficulty logging in, contact the CRMLS support department as described on page 51.

   ![SCOUT Login](image)

5. Click Login.

6. Read and agree to the Terms of Use and End User License Agreement to continue.

7. Answer the three secret questions that will be used to identify you in the event that you forget your password.

8. Follow the prompts on the screen to complete the enrollment process.
Once you have finished the enrollment process, you see the CRMLS Matrix Platform Home screen.

CRMLS Matrix Platform Navigation Overview

The CRMLS Matrix Platform utilizes navigation tabs to separate the different sections of the system.

Refer to the following sections for a description of the tabs and items available:

- “Home Tab” on page 6
- “Search Tab” on page 7
- “My Matrix Tab” on page 7
- “Add/Edit Tab” on page 8
- “Finance Tab” on page 9
- “Roster Tab” on page 9
- “Realist Tax Tab” on page 10
- “Links Tab” on page 10
- “Help Tab” on page 11
- “Logout Tab” on page 11
Home Tab

The Home tab gives you quick access to everyday tasks and is the first tab you see when you log in to the CRMLS Matrix Platform.

The Home tab gives you quick access to the following items:

- **News**: Displays current updates, releases, and important information from CRMLS and your Local Association/Board of REALTORS®.
- **Hot Sheets**: Displays the latest market changes from your custom criteria.
- **My Favorite Searches**: Displays up to 12 saved searches and provides instant access to view listing updates based on your saved search criteria.
- **External Links**: Provides access other CRMLS products and MLS systems, provided by your Local Association/Board of REALTORS®.
- **Recent Portal Visitors**: Displays a list of clients that have viewed listings sent using the Email Portal feature.
- **Recent Use Contacts**: Displays a list of your most recent clients in the CRMLS Matrix Platform.
- **My Carts**: Displays a list of all listings for each property type in your cart folder.
- **My Listings**: Displays a summary of your listings and allows you to quickly access them.
- **Market Watch**: Displays market changes from your custom criteria.
- **My Stats**: Provides quick access to your saved Stats Presets.
- **Concierge**: Displays a list of Auto Emails that contain listings waiting for approval.
**Search Tab**

The search tab allows you to search for listings by property type, including Residential, Residential Income, Residential Lease, Land/Lot, Mobile Homes, and Listing Crossproperty. You can also search for Open Houses, Caravans, Property History, and Change Type History.

**Note:**
To search for Commercial/Industrial properties, Commercial Leases, or Business Opportunities, use the CARETS Commercial system instead. To access CARETS Commercial, click the CARETS Commercial link on the Links tab of the CRMLS Matrix Platform.

**My Matrix Tab**

The My Matrix tab allows you to manage your contacts, auto emails, saved searches, manage your listings, and customize your account settings.
**Add/Edit Tab**

The Add/Edit tab allows you to add listings, modify listings and open houses, and retrieve partially completed listings in the Work Area. You can also edit your contact information (see “Verify Your Contact Information” on page 13 for details).

**Note:**

Partialy saved listings in the Matrix Platform are available in the Work Area until you remove them. Draft listings from Discover CA were not migrated to the CRMLS Matrix Platform.
**Finance Tab**

The Finance tab contains Netsheets and various home financing, personal financing, investment, and retirement calculators.

![Finance Tab Image](image)

**Roster Tab**

The Roster tab allows you to search for agents and offices in the CRMLS Matrix Platform and from all CARETS Member MLSs.

![Roster Tab Image](image)
**Realist Tax Tab**

The Realist Tax tab allows you to access an integrated tax database that combines public records, listing data, maps, and market data in a single research tool.

Realist Tax covers all counties in California and is updated frequently.

**Links Tab**

The Links tab allows you to access other CRMLS products and MLS systems, provided by your Local Association/Board of REALTORS®.
**Help Tab**

The Help tab contains links to helpful information such as reciprocal links and passwords, CARETS rules and policies, photo purchase policies, frequently asked questions, training classes schedules, CRMLS news, IDX solutions and policy, VOW rules and policy, and the CRMLS download center to obtain Listing Input Forms and the CRMLS 1004MC spreadsheet.

**Logout Tab**

When you’re finished working in the CRMLS Matrix Platform, click the Logout tab to sign out, then close your web browser.
Follow the steps in these sections to verify your contact information, listings, contacts, and saved searches were migrated to the CRMLS Matrix Platform. Once you’ve verified that your information was transferred over, you can re-enable your auto prospects as necessary.

- “Verify Your Contact Information” on page 13
- “Create an Email Signature” on page 15
- “Create Headers and Footers” on page 16
- “Check your Contacts” on page 19
- “Check Your Listings” on page 20
- “Update Your Listings” on page 23
- “Check Your Saved Searches and Auto Prospects” on page 26
- “Re-enable Auto Prospects (Auto Emails)” on page 27
- “Download the Latest Listing Input Forms” on page 31
- “Download the Latest 1004MC Solution and Manual” on page 31
1. Verify Your Contact Information

Your contact information is one of the most valuable pieces of information you can provide to CRMLS members. The CRMLS Matrix Platform also displays your contact information on agent and client reports and displays. Follow the steps below to update your contact information and preferred contact order.

1. Click the **Add/Edit** tab.

2. Under Roster, type your **Public ID** (Discover CA Username) in the **Quick Modify** field, then click **Edit**.

3. Click **Change Contact Information**.
4. Update your contact information and preferred contact order using the available fields.

5. Verify that your Email address is up to date and monitored regularly. The Email address on file is used by the CRMLS Matrix Platform to send you notifications and not having a valid email address on file can lead to poor performance or loss of features.

6. When you’re done click **Submit Agent** to save your updated contact information.
2. Create an Email Signature

When you send an email from the CRMLS Matrix Platform, your email signature will appear at the bottom of the email. Follow the steps below to create an email signature in CRMLS Matrix.

1. Click **Settings** on the My Matrix tab.

2. Enter your Email Signature.

3. Click the **English Check Spelling** link to spell check your email signature.

4. Click **Save Email Signature** when you're done entering your email signature.
3. Create Headers and Footers

The CRMLS Matrix Platform allows you to create a Header and Footer that’s appended to emails and on your printed displays and reports with a custom picture, logo, motto, and personal contact information. Follow the steps below to customize your Header and Footer.

1. Click the **Settings** link on the My Matrix tab.

![Settings link on My Matrix tab]

2. Click the **Header & Footer** link.

![Header & Footer link]
3. Select one of the Available Header/Footer Packages.

**Note:**
If you don’t want to include your photo in the header/footer, select one of the No Photo headers/footers.

4. Click the **Next: Set my Information** button when you’re done selecting a header/footer package.

5. Scroll down to the Details section and click the **Click here to prefill your details** link to pre-fill your contact information from the Matrix roster or manually enter your contact information.
The information you enter will be displayed on all of your client portal and report headers and footers.

6. If you selected a header/footer that allows you to include your photo, click the **Browse** button.
7. Locate and select the photo you want to upload.
8. Click the **Preview** button to preview your header and footer.
9. Click the **Save** button to save your header and footer.
4. Check your Contacts

Follow the steps below to verify that all of your contacts were migrated to the CRMLS Matrix Platform.

1. Click the **Contacts** link on the **My Matrix** tab.

![Contacts link](image1)

2. Verify that all of your contacts were migrated. To sort your contacts alphabetically, click the **Name** link. To search for a contact, type a name in the **Search** field.

![Sort and search contacts](image2)

**Note:**

*Contacts that did not contain a first name or last name were not migrated to the CRMLS Matrix Platform. If any of your contacts were missing an email address, the client’s email address field was populated with your email address.*

If you’re missing any contacts, contact the CRMLS support department as described on page 51.
5. Check Your Listings

Follow the steps below to verify that all of your listings were migrated to the CRMLS Matrix Platform.

1. Click the My Listings link on the My Matrix tab.

2. Verify that all of your listings were migrated to the CRMLS Matrix Platform. If you have multiple listings you may need to click the Next link at the bottom of the list to move to subsequent pages of listings.
3. Once you’ve verified that all of your listings have been migrated, click the ML# link for first listing in the list.

4. Click the Open all link above the primary listing photo and verify that all of the listing’s photos were migrated.

5. If your listing contained supplements, click the Click Here for Supplements link and verify that all of the listing’s supplements were migrated.
6. Scroll down the page and check all of the listing’s details and verify that they are correct. If any of your listings have incorrect information, make a note of it.

**Note:**

*Depending on the length of the fields in your previous MLS and the CRMLS Matrix Platform, it is possible that some fields may be truncated. If you don’t see a field that was included in your previous MLS, check the Property Description and Agent Remarks fields.*

7. Click the **Next** link at the bottom of the listing to move to the next listing.

8. Repeat steps 4 through 7 to verify the rest of your listing.

If you’re missing listings or notice any problems with your listings, contact the CRMLS support department as described on page 51.
6. Update Your Listings

Some fields that weren’t required or that didn’t exist in Discover CA are now required fields in the CRMLS Matrix Platform. To avoid potential violations, you will need to update all of your listings and fill out all newly required fields. Follow the steps below to update your listings.

1. Click the Add/Edit tab.

2. Select the first listing you want to modify in the Quick Modify drop-down menu.

**Note:**
You can also type the Multiple Listing Number in the ML# field and click *Edit.*
3. Click the **Detail** link on the Modify Listing screen. You see the Listing Input Wizard.

4. Click the tabs to move through each section of the Listing Input Wizard and make changes to your listing as necessary.

All fields highlighted in yellow are required and must be filled out before you can submit your listing.

**Note:**
*Area information is currently not available for Amador, Chico, Oroville, Paradise, Madera, Mariposa, Merced, Tehama, and Yosemite Gateway.*
5. When you’re done modifying your listing, click **Submit Listing** to save your changes.

If any required fields are missing information or if the listing contains warnings or errors, the ❌ error or ⚠️ warning symbol will appear next to each section and field that needs to be updated. Click the tab with the error or warning and make corrections as necessary. All errors must be corrected before the listing can be submitted.

6. Repeat steps 1 through 5 to update the rest of your listings.
7. Check Your Saved Searches and Auto Prospects

Saved Searches and Auto Prospects from Discover CA were migrated to the CRMLS Matrix Platform as Saved Searches. Follow the steps below to verify that your Saved Searches and Auto Prospects were migrated to the CRMLS Matrix Platform.

**Note:**
Auto Prospects that were migrated to the CRMLS Matrix Platform have been disabled. To re-enable your Auto Prospects, refer to “Re-enable Auto Prospects (Auto Emails)” on page 27.

1. Click the **Saved Searches** link on the **My Matrix** tab.

2. Verify that your saved searches were migrated.

**Note:**
Due some carryover of pre-Discover CA search criteria, a small number of Saved Searches and Auto Prospects were not able to be migrated to the CRMLS Matrix Platform.

If you’re missing any Saved Searches or Auto Prospects, contact the CRMLS support department as described on page 51.
8. Re-enable Auto Prospects (Auto Emails)

Auto Prospects from Discover CA are equivalent to the CRMLS Matrix Platform’s Auto Email feature. Auto Prospects were migrated to the CRMLS Matrix Platform as Saved Searches. Follow the steps below to turn your Saved Searches into Auto Emails for your clients.

1. Click the **Saved Searches** link on the **My Matrix** tab.

2. Locate the Saved Search you want to turn into an Auto Email notification.

3. Click the triangle next to the Saved Search to display the Saved Search options.

   ![Saved Searches](Image)

   **Note:**
   If you have a large number of Saved Searches, you can filter them using the **Filter Saved Searches** drop-down menu.
4. Click **Revise** to update your Saved Search criteria before turning it into an auto email.

5. Review and modify your search criteria as necessary, then click **Save**.

**Note:**
*Saved Searches that return more than 250 listings cannot be turned into an Auto Email.*
6. Click the **Turn this Saved Search into an Auto Email** link.

7. Select a contact from the **Contact** drop-down list to assign the auto email to an existing contact. To add a new contact, click the **Create a New Contact** link, then see follow the prompts on the screen.

8. Enter a subject for the email in the **Subject** field.

9. Select **BCC me a copy of all emails** to receive a blind carbon copy of auto emails sent to the client.

10. If you want to send the auto email to an additional email address, the address in the **CC:** field.
11. If you want to send the auto email to an additional email address without the client seeing who it was sent to, enter the address in the BCC: field.

12. CRMLS Matrix will automatically populates the message field. If you want to add a personal message before the auto populated text, enter it in the Message field.

   **Note:**
   *When sending the initial auto email to a client, you should leave the Message field blank. This will send out a message welcoming your client to the Portal and provide them with general information on how to work with the Portal.*

13. Select **Make available for Reverse Prospecting** to allow a listing agent to see if their listing was sent in an auto email.

   ![Settings](image)

   **Note:**
   *Client information is never shared with Listing Agents when Reverse Prospecting is enabled.*

14. Select **Enable as a Favorite Search** to add the search to the Favorite Searches widget on the CRMLS Matrix Home tab.

15. Select a Schedule setting to specify when auto emails are sent to your client. The **Daily** setting allows to send emails every day at 8:00AM or 6:00PM, the **ASAP** setting sends auto emails as soon as possible, and the **Monthly** setting sends emails at midnight on the first of the month.

16. Click the **Save** button to save your Auto Email.

   **Note:**
   *If your Auto Email returns more than 250 listings, you will receive a message letting you know that your Auto Email has been disabled. To reactivate your auto email, access your Saved Search in the My Matrix tab, narrow your search criteria, and re-activate the Auto Email. If necessary, you can set up multiple saved searches for a single client.*
9. Download the Latest Listing Input Forms

Before you add or modify listings, be sure to download the new Listing Input Forms from http://www.crmls.org/centsite/listing_input_forms.htm.

10. Download the Latest 1004MC Solution and Manual

Before generating a 1004MC report, download the latest versions of the CRMLS 1004MC Solution and 1004MC Solution Manual from the Download Center on the CRMLS Matrix Platform’s Help tab. The 1004MC Solution Manual contains complete details on exporting comps from the CRMLS Matrix Platform and using the CRMLS 1004MC Solution spreadsheet.
Searching for Listings

Refer to the following sections to search for listings in the CRMLS Matrix Platform.

- “Basic Search” below
- “Map Search” on page 36
- “Viewing Search Results” on page 40

**Note:**
To search for Commercial/Industrial properties, Commercial Leases, or Business Opportunities, use the CARETS Commercial system instead. To access CARETS Commercial, click the CARETS Commercial link on the Links tab of the CRMLS Matrix Platform.

### Basic Search

Follow the steps below to perform a basic search. This example will guide you through performing a basic Residential search, however, the steps for performing a basic Residential Income, Residential Lease, Land/Lot, or Mobile Home search are similar.

1. Click the **Search** tab.
2. Click any of the search links for the type of property you’re searching for. In this example, we will be performing a **Quick** Residential search.

![Basic Search](image1)

3. Enter your search criteria. To select more than one item in a field, hold the **CTRL** key on your keyboard while clicking the desired items. To deselect an item, hold the **CTRL** key on your keyboard and click the item you want to remove.

![Basic Search](image2)

**Note:**
If you need help entering search criteria, click the ? icon next to the field you need help with. For a list of special characters allowed for search fields, See “Additional Search Options” on page 35.

*Area information is currently not available for Amador, Chico, Oroville, Paradise, Madera, Mariposa, Merced, Tehama, and Yosemite Gateway.*

4. Select a search results display format from the **Display** drop-down box. For example, to display search results as thumbnails, select **Agent Thumbnail**.

![Basic Search](image3)
5. Select the number of listings you want the search results to display per page. Available options are 10, 25, 50, or 100 listings per page.

6. You can also do the following:
   - Click **Clear** to remove all your search criteria and start over.
   - Click the **Clear** button to save your current criteria as your default search settings. To reset the criteria, click the **Clear** button.
   - View the number of listings that match your search criteria on the **matches** button.
   - Click the **matches** button to view your search criteria before searching.
   - Click **Add** to add additional search fields or remove search fields from the search page.
   - Click **Stats** to generate statistical charts and graphs for listings that match your search criteria.

7. Click the **Search** button, then continue with “Viewing Search Results” on page 40.
## Additional Search Options

Refer to the table below for a list of special characters allowed for search fields.

<table>
<thead>
<tr>
<th>Special Character</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Greater than or equal to:</td>
<td>Bathroom: 3+</td>
</tr>
<tr>
<td></td>
<td>Allows you to search for values that are</td>
<td>Finds all listings that have 3 or more</td>
</tr>
<tr>
<td></td>
<td>greater than or equal to the value you entered.</td>
<td>bathrooms.</td>
</tr>
<tr>
<td></td>
<td>When using the + character, it must follow the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>value you enter.</td>
<td></td>
</tr>
<tr>
<td>–</td>
<td>Less than or equal to:</td>
<td>Bathroom: 4-</td>
</tr>
<tr>
<td></td>
<td>Allows you to search for values that are</td>
<td>Finds all listings that have 4 bathrooms or</td>
</tr>
<tr>
<td></td>
<td>less than or equal to the value you entered.</td>
<td>less.</td>
</tr>
<tr>
<td></td>
<td>When using the – character, it must follow the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>value you enter.</td>
<td></td>
</tr>
<tr>
<td>–</td>
<td>Range:</td>
<td>List Price: 150000-200000</td>
</tr>
<tr>
<td></td>
<td>Allows you specify a numeric range.</td>
<td>Finds all listings with a list price ranging</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from $150,000 to $200,000.</td>
</tr>
<tr>
<td>,</td>
<td>Either/Or:</td>
<td>Type: SFR, CONDO</td>
</tr>
<tr>
<td></td>
<td>Allows you to enter multiple values in a</td>
<td>Finds all listings that are condominiums or</td>
</tr>
<tr>
<td></td>
<td>single field.</td>
<td>single-family residences.</td>
</tr>
<tr>
<td>*</td>
<td>Wildcard:</td>
<td>Street Name: *Park</td>
</tr>
<tr>
<td></td>
<td>Allows you to search for unknown letters and/or</td>
<td>Finds all listings that are located on a</td>
</tr>
<tr>
<td></td>
<td>numbers.</td>
<td>street that ends with the word Park.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Street name Park*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Finds all listings that are located on a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>street that begins with the word Park.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Property Description/Office Comments:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>key word</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Finds all listings with the &quot;key word&quot; in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the property description or office comments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use commas to separate multiple key words.</td>
</tr>
<tr>
<td>!</td>
<td>Exclude Selections:</td>
<td>Year Built: !1960</td>
</tr>
<tr>
<td></td>
<td>Allows you to exclude listings that contain a</td>
<td>Excludes all listings that contain properties</td>
</tr>
<tr>
<td></td>
<td>specific value for search criteria. When using</td>
<td>that were built in 1960.</td>
</tr>
<tr>
<td></td>
<td>the ! character, it must precede the value you</td>
<td>Agent Remarks: !&quot;fixer*</td>
</tr>
<tr>
<td></td>
<td>enter.</td>
<td>Excludes all listings that contain the word</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fixer in the Agent Remarks field.</td>
</tr>
</tbody>
</table>
Map Search

The CRMLS Matrix Platform allows you to include and exclude specific areas you want to search by drawing shapes on a map. Follow the steps below to search for properties within a selected area on a map.

1. Click the Search tab.

2. Click any of the search links for the type of property you’re searching for. In this example, we will be performing a Quick Residential search.
3. Click **Map Search**.

4. When you see the map screen, define the area you want to search using the **Jump to** drop-down menu or the **Locate Address** fields, then click the **Locate** button.
Note:
To set the map to always open to the selected area, click **Set Default Location**. If you want to reset the map to open to its default location, click **Clear Default Location**.

5. Use the Mark Search Region tools to draw multiple shapes that specify the areas you want to search.

To draw a Rectangle or Radius, click and drag your mouse across the map to define your search area.

To draw a Polygon, left-click each point of the area you want to search, then right-click the last point to finish drawing the polygon.

![Map Search Tools](image)

**Note:**
To exclude a certain area from your search, hover over the shape’s red number and select **Exclude this selection**. The shape turns from green to red to indicate that the selected area will be excluded from your search.

To delete a shape, hover over the shape’s red number and select **Delete selection**. To delete all of the search areas and start over, click the **Clear** link under Mark Search Region.

To re-center the map to the search area you selected, click the **Re-center** button.

6. Click **OK** to save the search area.

**Note:**
You must define a search area using one of the drawing tools in order to save the search area.
You see the search screen with a **Map Area Selected** message.

7. Select additional search criteria as necessary.

   **Note:**
   *When performing a Map Search do not select areas or cities outside of the area you selected on the map or you will not receive any results. If you need to clear the selected map, click **Clear Map**.*

8. Click the **Search** button, then continue with “Viewing Search Results” below.
Viewing Search Results

Once you click the Search button on any of the search pages, the CRMLS Matrix Platform displays a search results window like this one:

If you have any questions or concerns regarding the listings displayed on the search results page, contact the CRMLS support department as described on page 51. To help CRMLS troubleshoot the issue, our support department will ask you to copy and paste your search criteria into an email and include any questions you may have about the results.

Refer to these sections to navigate within the search results page:
- “Search Results Links and Displays” on page 41
- “Search Results Icons” on page 42
- “Search Results Buttons” on page 43
**Search Results Links and Displays**

Refer to the table below for a list of links and displays available on the search results window.

<table>
<thead>
<tr>
<th>Link or Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check All</strong></td>
<td>Click the <strong>Check All</strong> link to quickly select all listings on all search results pages.</td>
</tr>
<tr>
<td><strong>Next</strong></td>
<td>Click the <strong>Next</strong> link to view the next page of search results.</td>
</tr>
<tr>
<td><strong>Previous</strong></td>
<td>Click the <strong>Previous</strong> link to view the previous page of search results.</td>
</tr>
<tr>
<td><strong>1 [2] 3 4 5 6 7</strong></td>
<td>Click a number to jump to that page of search results. For example, click 3 to view the third page of search results. The number in brackets indicates the current search results page that you're viewing.</td>
</tr>
<tr>
<td><strong>Carts</strong></td>
<td>Click the <strong>Carts</strong> button to expand the Carts button bar. Click the <strong>Add to</strong> link to add the selected listings to the cart selected in the drop-down menu. Each Cart can have a maximum of 250 listings. You also can view the selected Cart from the search results page by clicking the <strong>Open</strong> button.</td>
</tr>
<tr>
<td><strong>ML# A12345678</strong></td>
<td>Click the Multiple Listing number link to view the full listing.</td>
</tr>
<tr>
<td><strong>St Name Main St</strong></td>
<td>Click the street name to view the listing on a map.</td>
</tr>
</tbody>
</table>
| **DOM/CDOM**    | Click the **DOM** link to view a history of the listing or the CDOM link to view a comprehensive history of the listing. The history will include price changes, selling office compensation changes, and the User ID of the change agent or entity.  
  
  **Note:**  
  To view property history by APN and/or Street Address, perform a **Property History** search from the Search tab. |
| **Display**     | Select a display format from the **Display** drop down box to change the search results display to one of the various display formats available.  
  
  **Note:**  
  You can change the default result display on the search page only. You can also change your listings per page from 25 to 10, 50, or 100. |
| **Search selected for** | You can view listing history, property history, or open houses of selected listings by selecting **Listing History**, **Property History**, or **Open House** in the **Search selected for** drop-down box. |
| **Criteria**    | The search criteria you selected is displayed at the bottom left side of the search results window. |
| **View as**     | Select a client in the drop-down menu to view search results as one of your clients. This allows you to quickly see which listings you have emailed to them and if they have marked any of them as Favorites, Possibilities, or Discarded. |
**Search Results Icons**

Refer to the table below for a list of icons available on the search results window.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Up Arrow Down Arrow]</td>
<td>Indicates that either the list price or sale price has changed. The up arrow means that the list price or sale price has increased and the down arrow means that the list or sale price has decreased. To view the listing's history, click the DOM or CDOM link.</td>
</tr>
<tr>
<td>![Checkmark]</td>
<td>Click the checkbox for each listing you would like to Narrow, Discard, Save, Sort, Print, Export, Email, or Map.</td>
</tr>
<tr>
<td>![Map]</td>
<td>Click the map icon to view the listing on a map.</td>
</tr>
<tr>
<td>![Camera]</td>
<td>Click the camera icon to view a photo of the listing. Listings with a camera icon with a plus indicate that there are multiple photos available for that listing.</td>
</tr>
<tr>
<td>![Realist Tax]</td>
<td>Click the Realist Tax icon to open the listing in Realist Tax. Realist Tax combines public records, CRMLS listing data, maps, and market data into a single research tool.</td>
</tr>
<tr>
<td>![Binoculars]</td>
<td>Click the binoculars icon to add the listing to your Watched Listings. To view your watched listings, click <strong>Watched Listings</strong> on the My Matrix tab.</td>
</tr>
<tr>
<td>![Movie]</td>
<td>Click the movie icon to view the listing’s virtual tour.</td>
</tr>
</tbody>
</table>
Search Results Buttons

Refer to the table below for a list of buttons available on the search results window.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Revise](revise.png) | Click the **Revise** button to change your search criteria.  
**Note:**  
*Clicking the Revise button is better than clicking your browser’s Back button.* |
| ![Email](email.png) | Click the **Email** button to email the selected listings to your clients (see page 46). |
| ![Report](report.png) | Click the **Report** button to generate a report of the selected listings in PDF format. You can also print the generated PDF report or email customer reports to your clients for their review (see page 44).  
**Note:**  
*This is the best way to print listings.* |
| ![CMA](cma.png) | Click the **CMA** button to generate a CMA report of the selected listings using the CRMLS Matrix Platform’s CMA Wizard. |
| ![Map](map.png) | Select multiple listings, then click the **Map** button to display all of the selected listings on one map and to get driving directions (see page 32). |
| ![Stats](stats.png) | Click the **Stats** button to generate a chart, graph, or tabular view of statistics. |
| ![Save As](save_as.png) | Click the **Save As** button to save your search criteria. To view your saved searches click the **Saved Searches** link on the My Matrix tab. You can also create Auto Emails or Speedbar Shortcuts from your saved searches. |
| ![Narrow](narrow.png) | Click the **Narrow** button to display only the listings you selected on the search results pages. You can narrow up to 500 listings. |
| ![Discard](discard.png) | Click the **Discard** button to remove the selected listings from the search results page. You can discard up to 500 listings. |
| ![Sort](sort.png) | Click **Sort** button to sort your search results by any field, such as the list date, sold date, etc. You can sort up to 500 listings. The default sort order is Status, Area, and Price. |
| ![Print Page](print_page.png) | Click the **Print Page** button to print the search results directly from your browser. To change the view to show a different display such as a Customer Flyer, use the Display drop-down box to select one of the various display options before clicking the Print Page button. |
| ![Export](export.png) | Click the **Export** button to download the selected listings and pictures to your favorite software program, such as 1004mc, Full, Pocket Real Estate, Top Producer and more. Agents can export up to 500 listings per export and brokers can export up to 2,000 listings per export. |
Follow the steps below to print listings and reports. Before you begin, make sure that you’ve performed a search as described in “Searching for Listings” on page 32.

1. Click the checkbox next to each listing you want to print.

2. Click the Report button.
3. Select the report you want to generate from the list.

![Image of CRMLS Matrix interface showing print options]

**Note:**
To select more than one report, hold down the **CTRL** key on your keyboard as you select the reports you want to print.

4. Click the **Print/View** button to generate a PDF of each report you selected.

To print the generated PDF report, use your web browser's built-in print command.

You can also save the generated report by selecting the save option in your web browser.
Emailing Listings

The CRMLS Matrix Platform allows you to email listing reports or links to listings, for display in the Client Portal, directly from the search results page. Follow the steps in these sections to get started:

- “Emailing Listings for Display in the Client Portal” below
- “Emailing listings as a PDF Report” on page 48

Emailing Listings for Display in the Client Portal

1. Click the checkbox next to each listing you want add to your client’s Portal.
2. Click the Email button.
3. Click the **To:** or **CC:** button to select a recipient from your contact list. You can also manually type your client’s e-mail address in the **To:** field.

   **Note:**
   - To select more than one contact, hold down the **CTRL** key on your keyboard as you select them.
   - If your e-mail address doesn’t appear in the **From:** field, you will need to add your e-mail address to your CRMLS Matrix account. Click the **Add/Edit** tab, type your Agent ID in the **Quick Modify** field under Roster, then click the **Edit** link.

4. Click the **Bcc me a copy of this message** checkbox to receive a copy of the email you’re sending.

5. Enter a subject for the e-mail in the **Subject** text field.

6. Enter a message for your client in the **Email Body** text field. You can enter up to 4096 characters in the **Email Body** text field.

7. Click the **English** link to spell check the message you typed in the **Email Body** text field.

8. Click the **Preview** button to preview the email message before sending it to your client.

9. Click the **Send** button to send the selected listings to your client.
Emailing listings as a PDF Report

Follow the steps below to email listing reports. Before you begin, make sure that you’ve performed a search and are on the search results page.

1. Click the checkbox next to each listing you want to email in a report.
2. Click the **Report** button.

3. Select the report you want to email.

   To select more than one report, hold down the **CTRL** key on your keyboard as you select the reports you want to email.
Note: To preview the Report, click the Print/View button.
Agent Reports are not available to email.

4. Click the Email button.

5. Click the To: or CC: button to select a recipient from your contact list. To add a new client to your contact list, click Create a New Contact.

   ![Email Reports screenshot]

   Note: To select more than one contact, hold down the CTRL key on your keyboard as you select them.

   If your e-mail address doesn’t appear in the From: field, you will need to add your e-mail address to your CRMLS Matrix account. Click the Add/Edit tab, type your Agent ID in the Quick Modify field under Roster, then click the Edit link.

6. Click the Bcc me a copy of this message checkbox to receive a copy of the email you’re sending.

7. Enter a subject for the e-mail in the Subject text field.

8. Enter a message for your client in the Email Body text field. You can enter up to 4096 characters in the Email Body text field.

9. Click the English link to spell check the message you typed in the Email Body text field.

10. Click the Send button to send the selected report to your client in PDF format.
Searching for Open Houses

Follow the steps below to search for Public, Broker, and Office Open Houses.

1. Click the **Search** tab, then click the **Quick** link under **Open House**.

2. Enter your search criteria. To select more than one item in a field, hold the **CTRL** key on your keyboard while clicking the desired items. To deselect an item, hold the **CTRL** key on your keyboard and click the item you want to remove.

   **Note:**
   *If you need help entering search criteria, click the ? icon next to the field you need help with. For a list of special characters allowed for search fields, See “Additional Search Options” on page 35.*

   *Area information is currently not available for Amador, Chico, Oroville, Paradise, Madera, Mariposa, Merced, Tehama, and Yosemite Gateway.*

3. Click the **Search** button, to view Open Houses that match your search criteria.
Customer Support

To contact our technical support department, visit our website at http://www.crmls.org and click the SUPPORT button. Then click the Submit Support Request or Suggestions link to submit a support request or a suggestion (we value your suggestions).

If you need immediate assistance, our customer support technicians are available to answer your questions Monday through Friday from 8:30 AM to 9:00 PM and on Saturday and Sunday from 10:00 AM to 3:00 PM.

Toll Free Number:  (800) 925-1525
On the web:  http://www.crmls.org/support
Training Resources

CRMLS takes pride in providing quality training materials and training resources to fit all of our member’s schedules and individual learning styles. Training resources can be found by visiting http://www.crmls.org and clicking on the TRAINING button.

CRMLS offers the following types of training:

- **Webinar Training (Web Conference):** On-line training classes that can be taken from the comfort of your home or office (requires a phone and high speed Internet access).

- **Hands-On Training:** Classroom style training classes held at the CRMLS offices in Pomona. Seating for these classes is limited, so be sure to sign up for them at the beginning of each month.

- **Instructor-Led Training:** Classroom style training classes held at your local association. Check the Training Calendar for a list of available classes.

- **Online Video Training:** Learn at your own pace with our on-demand video tutorials.

- **Product Documentation:** Download PDF copies of product manuals or download replacement training materials (requires Adobe Reader 7.0 or later).
CRMLSMobile allows you to search for Listings from your mobile devices. Follow the steps below to get started.

2. Enter your User ID and Password in the fields.
3. Click the Login button and start searching for listings.

*Note:* Access to CRMLSMobile is free, however, your wireless carrier may charge extra for Internet usage on your mobile device. Please contact your wireless carrier for Internet data rates and charges.

### Adding a Public Search Link to Your Website

Follow the steps below to add a public search link to your website.

1. Open your web browser, go to http://www.crmls.org/support.
2. Click Link Generator in the Download Center.
3. Enter your Username in the **Public ID** field and your Office Code in the **Office Code** field.

4. Select a language from the list of available languages.

5. Click the **Get Links** button.

6. Click the **Copy to clipboard button** to copy the generated code.

7. Create a new email, paste the generated code into the email, and send it to your website provider.

   **Note:**
   *There are three available links for your website, a General Public Search, an Agent Listings link, and an Office Listings link.*